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MCP3903 ADC EVALUATION BOARD
FOR 16-BIT MCUs USER’S GUIDE
Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
MCP3903 ADC Evaluation Board for 16-Bit MCUs. Items discussed in this chapter 
include:
• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Web Site
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This document describes how to use the MCP3903 ADC Evaluation Board for 16-Bit 
MCUs as a development tool to emulate and debug firmware on a target board. The 
manual layout is as follows:
• Chapter 1. “Hardware Description”– Provides important information about the 

hardware.
• Chapter 2. “Code example”– Describes the firmware. 
• Appendix A. “Schematics and Layouts”– Shows the schematic and board 

layouts.
• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 

MCP3903 ADC Evaluation Board for 16-Bit MCUs.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available on-line help files.
© 2011 Microchip Technology Inc. DS51994A-page 1
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CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h
Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1
Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS51994A-page 2 © 2011 Microchip Technology Inc.



Preface
RECOMMENDED READING
This User's Guide describes how to use MCP3903 ADC Evaluation Board for 16-Bit 
MCUs. Other useful documents are listed below. The following Microchip document is 
available and recommended as a supplemental reference resource:
• MCP3903 Data Sheet - “Six Channel Delta Sigma A/D Converter” 

(DS25048B)

THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: http://support.microchip.com.

DOCUMENT REVISION HISTORY

Revision A (July 2011)
• Initial Release of this Document.
© 2011 Microchip Technology Inc. DS51994A-page 3
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MCP3903 ADC EVALUATION BOARD
FOR 16-BIT MCUs USER’S GUIDE
Chapter 1.  Hardware Description
1.1 OVERVIEW
The MCP3903 ADC Evaluation Board for 16-Bit MCUs system lets users evaluate the 
performance of the MCP3903 six-channel ADC. It also provides a development 
platform for 16-bit PIC® MCU-based applications, using existing 100-pin PIM systems, 
compatible with the Explorer-16 and other high pincount PIC demo boards. The system 
comes with programmed PIC24FJ128GA010 PIM modules that communicate with the 
LabView GUI for data exchange and ADC setup.

1.1.1 Feature Highlights
• Six-channel ADC MCP3903 output display using serial communication to the 

PC Software Interface and LCD
• Simultaneous 4 ksps at 91 dB Signal-to-Noise and Distortion Ratio (SINAD) 

performance. The ADC can run up to 64 ksps.
• System and ADC performance analysis through graphical PC tools showing Time 

domain scope plot, Frequency Domain (FFT), and statistical numerical analysis.
• Robust hardware design with analog grounding and analog/digital separation, 

allowing low noise evaluation of the MCP3903 devices. Separate power supplies 
and power planes - 4 layer board.

• Pigtail Plus connectors for Explorer-16 daughter board compatibility.
© 2011 Microchip Technology Inc. DS51994A-page 5
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FIGURE 1-1: MCP3903 ADC Evaluation Board for 16-Bit MCUs.
DS51994A-page 6 © 2011 Microchip Technology Inc.



Hardware Description
1.2 PIM MODULE / MCP3903 CONNECTION AND PERIPHERAL USAGE 
OVERVIEW

The MCP3903 ADC Evaluation Board for 16-Bit MCUs contains a 100-pin PIM socket, 
compatible with Microchip’s PIM modules. The system comes with a PIM module: the 
PIC24FJ128GA010. 
For a complete description of the firmware programmed with these two modules, see 
Chapter 1. “Hardware Description”.
  

FIGURE 1-2: Digital Connection Overview PIM/MCP3903 Connections.

Ports A, B, and D are used for signals such as push buttons, output LEDs, CS and 
MCLR (for MCP3903 data mode setting). Output Capture 1 is used for MCP3903’s 
clock generation. Serial communication is achieved through the MSSP module 1.
The MCP3903 device is an ADC with a second order modulator and a third order sync 
filter. This Delta-Sigma A/D converter has an adjustable oversampling ratio. The CLKIN 
pin of the MCP3903 is the ADC’s clock (MCLK) input. The MCP3903 ADC Evaluation 
Board for 16-Bit MCUs offers two different options for the MCP3903 master clock 
(MCLK). 
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1.2.1 Using the Crystal X2
The MCP3903 ADC Evaluation Board for 16-Bit MCUs is populated with a 3.58 MHz 
crystal, being used as a clock source, by placing jumpers in the following position on 
the MCP3903 Digital I/O header block:
    

FIGURE 1-3: ADC Clock Selection Jumpers - External Crystal.

1.2.2 Driving the Clock with the PIM Module
The PIC® MCU can be used to generate the CLKIN (MCLK) signal for the MCP3903, 
setting the ADC sample rate through the use of the output compare module OC1. To 
use this, make the following jumper change to the MCP3903 Digital I/O header block:
  

FIGURE 1-4: ADC Clock Selection Jumpers - Clock from MCU.

The signal frequency from OC1 can be changed by the user from the PC software by 
changing the value in the Sampling Speed Control box from the Edit menu. A low 
number will generate a high frequency signal. The value of the sampling rate, which is 
directly proportional to the clock frequency from OC1, is indicated in the sampling 
speed indicator box in the PC software (see Figure 2-3) for the dsPIC33 example. In 
the PIC24F example, the sampling speed is constant at 4.8 ksps, regardless of the 
OSR value.

XTAL
XTAL
PIM OC1CLKIN

CLKIN
CLKOUT

XTAL
XTAL
PIM OC1CLKIN

CLKIN
CLKOUT
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Hardware Description
1.3 ANALOG INPUT STRUCTURE
Two differential input paths allow external signal sources to be easily connected to the 
MCP3903 input. Edge connectors JP1 and JP2 are 3-pin connectors that act both as 
crew-type and clip-on post connectors.

JP1 and JP2 can be used to force either channel from a differential to a single-ended 
configuration. R3 and R4 (on CH0), and R1 and R2 (on CH2) act as locations for 
burden resistor connectors for any current transformer inputs.

1.4 USB TO SERIAL CONVERTER
The MCP3903 ADC Evaluation Board for 16-Bit MCUs also contains a USB connection 
for connecting the evaluation board to a PC. On the board, there is an MCP2200 USB 
to UART converter that creates a virtual COM port on the PC. The MCP3903 ADC 
Evaluation Board for 16-Bit MCUs also features a RS232 connector just in case it is 
required. The RS232 Line driver is connected to the same UART pins of the MCU. For 
this reason, a 3-pin jumper (J5) is present on the evaluation board to select which serial 
communication will be used: USB or RS232. The following figure summarizes the 
connections between the ADC, MCU, USB to serial converter and RS232 line driver. 
  

FIGURE 1-5: Serial Communication Block Diagram.

Note: To use an edge connector as a post connector, pull up the blue plastic top 
to access the posts.
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Chapter 2.  Code Example
2.1 DSPIC33 EXAMPLE DESCRIPTION
If the user needs to evaluate the ADC on a system that uses dsPIC33 microcontrollers, 
then a PIM connector with a dsPIC33FJ256GA710A can be used on the evaluation 
board.
Using this example, the user can modify all MCP3903 internal registers from the PC 
software “MCP390x Data VIEW”. The UART communication speed is at 115.2 kbps.

2.1.1 SPI Communication
To transfer data from the ADC to the MCU, the SPI communication is controlled by 
DMA1. DMA1 channel is set up to use nul data write to read the MCP3903 register 
correctly. The DMA1 reads 7 bytes, but the first byte is not used. Before a new DMA 
read takes place, the CS pin must be controlled in the software and the MCU must wait 
for a new external interrupt 3 that indicates a new acquisition.
After the DMA1 transfer is finished, the DMA buffer content is moved into the Vch0 and 
Vch1 buffers. The loop is repeated until Vch0 and Vch1 are filled.
Timer 8 and Timer 9 are configured to work as a 32-bit timer. This timer starts when the 
acquisition is started and stopped when data buffers are full. The value indicated by this 
timer will be used to evaluate the sampling speed of the ADC on the PC interface.
After the buffers are filled with the samples, the internal registers of MCP3903 are read 
also using DMA1, now configured to read 16 bytes. The state of the MCP3903 internal 
registers will be stored into the MCU, since later they will be sent to the PC GUI.
To set the MCP3903 configuration registers, MCU must write on the SPI bus. For this 
purpose, the DMA0 channel is used and is set to do a thirteen bytes transfer from MCU 
to MCP3903.

2.1.2 UART Communication
To send the acquired samples from the MCU to the PC, the UART peripheral is used. 
On the board, the user can use the RS232 DB9 connector to connect to a serial port 
on PC side, or it can use the USB port that creates a virtual serial port on the PC, thanks 
to the MCP2200 USB to TTL converter that is connected to the MCU.
The RX pins of the MAX2323 and the MCP2200 are tightened together with the TX pin 
of the UART2 from the MCU. The user needs to select from jumperJ5 if the MCU 
receives data from MCP2200 or MAX2323. In firmware, the MCU is using DMA2 to do 
the transfer from MCU to the PC. To receive data from the PC through UART, the RX 
interrupt is used.
© 2011 Microchip Technology Inc. DS51994A-page 11
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FIGURE 2-1: dsPIC33 Example Flow Chart.

2.1.3 PC Software
The PC receives the data and displays it on the MCP390x Data View. The program can 
display and process only two channels at the same time. To select the desired 
channels, the SW4 (RD13) must be pressed.
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Code Example
FIGURE 2-2: MCP3903 Data View Software - Main Screen.

Connectivity is done through the serial port. First, the user must identify the com port 
number from My computer > Manage > Device Manager. After this, in “VISA resource 
names”, users must find and select the correct com port number. Only after this, can 
the START button be pressed to begin the data acquisition.

FIGURE 2-3: MCP3903 Data View Software - Registers and Settings Screen. 

From the Edit menu, the user can open the Registers and Settings window to control 
the internal registers of the MCP3903, the sampling speed of the ADC or if any 
averaging should be done on the acquired samples.
From the buffer length, the user can select the amount of data that will be processed. 
The maximum length is 512. From the Sampling Speed Control, the user can change 
the sampling speed of the ADC. By writing a lower value, the sampling speed is 
increased, and for higher values it is decreased. The accurate value of the sampling 
speed is indicated in the Sampling speed indicator.
If the user wants to investigate the effect of averaging on the performance indicator, the 
desired value can be written in the “Averages” control. It must be noted that the 
processed buffer will decrease by a factor equal to the value of the average.
The Write Register and Read Register tabs are used to set the internal registers of 
the MCP3903. With the Write Register tab they are written and with the Read 
Register tab, the user can check the settings of the registers.
© 2011 Microchip Technology Inc. DS51994A-page 13
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The Waveform Graphs will show the signal in Time domain, while the Signal Spectrum 
graphs shows the signal in Frequency domain. From the Graphs menu, under the 
Signal Spectrum option, the user can find the Switch Y-axis scale option. From here, 
it is possible to change the Y axis of the Signal Spectrum in linear scale or in logarithmic 
scale. The spectrum signal information is obtained by performing a Fast Fourier 
transformation over the Time domain signal. This Fourier transformation can be done 
after the signal has been windowed. For this, the user must select the type of window 
from the Window control on the lower area of the main window.
The Histogram Graph can be used to investigate the distribution of the codes. This is 
especially helpful to check if a DC signal distribution is Gaussian. From the Graphs 
menu, under the Histogram option, the user can Change the number of bits, with the 
default being 40.
The indicators from the lower area of the program indicate other performance 
parameters of the ADC. The main one is SINAD and related to it is Effective Number 
of Bits (ENOB), used to indicate the AC signal performance. The ENOB value is 
computed according to the formula below: 

EQUATION 2-1:

For DC signals, the Noise RMS signal in µV is displayed. For AC signals, the indicator 
will show the RMS value of the signal.

ENOB SINAD 1.76–
6.02

------------------------------------=
DS51994A-page 14 © 2011 Microchip Technology Inc.
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Appendix A. Schematics and Layouts
A.1 INTRODUCTION
This appendix contains the following schematics of the MCP3903 ADC Evaluation 
Board for 16-Bit MCUs.

• Schematic - Analog
• Schematic - LCD and UART
• Schematic - USB and Memory
• Schematic - Microcontroller (MCU)
• Schematic - PIM Module
• Schematic - Power
• Board - Top Trace and Top Silk
• Board - Bottom Trace and Bottom Silk
• Board - Layer #2 VDD
• Board - Layer #3 GND
• Board - Top Silk and Pads
• Board - Bottom Silk and Pads
© 2011 Microchip Technology Inc. DS51994A-page 15
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A.2 SCHEMATIC - ANALOG
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A.3 SCHEMATIC - LCD AND UART 

R
ev

5

A
B

1

Si
ze

Ti
tle

D

En
g:

3 421

A
B

4321

3/
18

/1
0

6

D
at
e

LC
D
_E

XP
LO

R
ER

 1
6.
SC

H
D
O
C

C

Sh
ee

t

D
ra
w
n 
by

:

of

R
ev

C
D

B.
Po

pe
sc
u

A.
H
ap

en
ci
uc

D
es

cr
ip
tio

n

Fi
le
na

m
e:

B

D
at
e:
M

5

In
iti
al
 D

es
ig
n

2

+3
.3
V

+5
V

VE
E

+3
.3
V

R
B1

5/
PM

PA
0

R
D
5/
PM

PR
D

R
D
4/
P
M
P
W
R

G
N
D
A

R
B1

5/
PM

PA
0

R
D
5/
PM

PR
D

R
D
4/
P
M
P
W
R

TXR
XR
C
14

R
D
15

/U
1R

TS

TXR
X

+3
.3
V

+3
.3
V

VE
E +3
.3
V

G
N
D
A

G
N
D
A

G
N
D
A

G
N
D
A

G
N
D
A

R
E7

/P
M
PD

7

R
E6

/P
M
PD

6

R
E5

/P
M
PD

5

R
E3

/P
M
PD

3

R
E2

/P
M
PD

2

R
E1

/P
M
PD

1

R
E0

/P
M
PD

0

R
E7

/P
M
PD

7

R
E6

/P
M
PD

6

R
E5

/P
M
PD

5

R
E4

/P
M
PD

4

R
E2

/P
M
PD

2

R
E1

/P
M
PD

1

R
E0

/P
M
PD

0

R
D
14

/U
1C

TS

R
C
13

R
F3

/U
1T

X

U
6R

X

1.
3KR
16

10
K

R
15

10
0N

F

C
12

G
N
D
A

N
O
N
E

R
17

N
O
N
E

R
18

R
E4

/P
M
PD

4

R
E3

/P
M
PD

3

10
0N

F

C
34

100NF

C36

1KR
32

G
N
D
A

10
0N

F

C
30

G
N
D
A

G
N
D
A

1KR
33

10
0N

F

C
35

M
C
P3

90
3 
Ev

al
 B
oa

rd
 fo

r 1
6-
bi
t M

C
U

3/
31

/1
0

G
N
D

1

VC
C

2

R
S

4

E
6

R
/W

5

VC
3

D
B7

14

D
B4

11

D
B2

9

D
B5

12

D
B3

10

D
B1

8
D
B0

7

D
B6

13

LC
D
2

LC
D
_T

M
16

2J
C
A
W
G
1

10
0N

F

C
33

1 6 2 7 3 8 4 9 5

J3

D
B
9R

F

D
B7

11

D
B4

8

D
B2

6

E
3

D
B1

5
D
B0

4

D
B3

7

D
B5

9

D
B6

10

G
N
D
1

15

VC
C

13

R
S

1
R
/W

2

VE
E

14

G
N
D

12

LC
D
1

LC
D
_2

X1
6_

BO
TH

LC
D
/E
X
P
LO

R
E
R
 1
6

IN
VA

LI
D

11

T1
IN

13

R
1I
N

16

G
N
D

18

R
1O

U
T

15

T1
O
U
T

17

T2
IN

12

FO
R
C
EO

N
14

VC
C

19
FO

R
C
EO

FF
20

R
2O

U
T

10

T2
O
U
T

8

C
2+

5

V+
3

C
1-

4

C
2-

6

V
-

7

R
2I
N

9

EN
1

C
1+

2

S
N
75

C
32

23
P
WU
6

N
ET

00
05

2

N
ET

00
06

3

N
ET

00
06

4

N
ET

00
06

5

N
ET

00
06

6

N
ET

00
06

7

N
ET

00
06

8

N
ET

00
07

1

N
ET

00
07

3

N
ET

00
07

4

N
ET

00
07

5

© 2011 Microchip Technology Inc. DS51994A-page 17



MCP3903 ADC Evaluation Board for 16-Bit MCUs User’s Guide
A.4 SCHEMATIC - USB AND MEMORY

C

of
3

4

A
B

C
D

E

Fi
le
na

m
e:

Si
ze

Ti
tle

6

A.
H
ap

en
ci
uc

F

42

1

D
at
e:

3/
18

/1
0

B.
Po

pe
sc
u

31

A
B

C
D

E

R
E
V

F

2

Sh
ee

t
ds

PI
C
33

.S
C
H
D
O
C

En
g:

3

D
ra
w
n 
by

:

3

D
at
e

R
ev

is
io
n 
N
ot
es

M
4

+3
.3
V

+3
.3
V

+3
.3
V

R
D
13

R
D
6

R
D
7

PI
C
24

_M
C
LR

G
N
D
A

+3.3V

PI
C
24

_M
C
LR

R
B0

/A
N
0

R
B1

/A
N
1

R
B2

/S
S1

/A
N
2

R
B4

/A
N
4

R
B5

/A
N
5

R
E9

/IN
T2

R
E8

/IN
T1

R
A0

/T
M
S

U
SB

_S
S

PI
C
24

_M
C
LR

U
SB

_S
D
O

U
SB

_S
D
I

R
C
4

R
C
3

R
C
2

R
E6

/P
M
PD

6

R
E7

/P
M
PD

7

R
E5

/P
M
PD

5

R
G
15

+3
.3
V

+3
.3
V

RB6/AN6/PGC

RB7/AN7/PGD

RE4/PMPD4

RE3/PMPD3

RA10/PMPA6

+3.3V

RG13

RB8/AN8

RG14

RE1/PMPD1

RB10/PMPA13

RB9/AN9

RA7

RE0/PMPD0

EN
VR

EG

+3.3V

RG0

RG1

RA1/TCK

RF13/U2RTS

RF1

RF0

RB12/PMPA11VDDCORE

RB14/PMPA1

RB15/PMPA0

RD6

RD5/PMPRD

+3.3VRD13

RD4/PMPWR

VD
D
C
O
R
E

RD15/U1RTS

RF4/PMPA9/U2RX

RD3/PMPBE

RD2

RF5/PMPA8/U2TXRD1G
N
D
A

+3
.3
V

+3
.3
V

R
F3

/U
1T

X

R
F2

/U
1R

X

R
A2

/S
C
L2

R
A3

/S
D
A2

R
D
8

R
A1

5/
IN
T4

R
D
9

R
C
13

R
C
14

+3.3V+3.3V

39
03

_S
D
I

39
03

_S
C
K

39
03

_C
S

39
03

_R
ES

ET

39
03

_C
LK

IN +3.3V+3.3V

G
N
D
A+3.3V+3.3V

+3.3V+3.3V

+3.3V+3.3V

+3
.3
V

R
G
3/
SD

A1

R
G
2/
SC

L1

+3
.3
V

O
SC

1

O
SC

2

R
H
6

G
N
D
A+3.3V+3.3V

+3
.3
V

G
N
D
A

+3
.3
V

+3
.3
V

R
B3

/A
N
3

U
SB

_S
C
K

+3
.3
V G

N
D
A

39
03

_S
D
O

39
03

_D
R

10
0

R
39

RA9/PMPA7

G
N
D
A

G
N
D
ARA10/PMPA6

G
N
D
A

G
N
D
A

G
N
D
A

1K
R
14

1K
R
24

RA9/PMPA7

RG12

RE2/PMPD2

RB11/PMPA12

RF12/U2CTS

RA6

ENVREG

G
N
D
A

RB13/PMPA10

RD14/U1CTS

RD7

RD12

G
N
D
A

0.
0

R
26

G
N
D
A

N
O
N
E

R
29

G
N
D
A

G
N
D
A

+3
.3
V

G
N
D
A

R
H
7

G
N
D
A

R
D
8

G
N
D
A

SW
4

B3
S-
10

02
P

G
N
D
A

SW
1

B3
S-
10

02
P

G
N
D
A

1K
R
20

1K
R
31

G
N
D
A

N
O
N
E

R
25

0.
0

R
22

G
N
D
A

10
0N

F

C
24

10
0N

F

C
28

G
N
D
A

10
0N

F

C
20

10
0N

F

C
27

G
N
D
A

2.
2K

R
27

18
P
F

C
31

G
N
D
A

G
R
EE

N

D
6

S
M
L-
51

2M
W

10
0N

F

C
14

G
N
D
A

18
P
F

C
32

R
EDD
7

G
M
1J

R
35

20
0A

E

10
0

R
38

SW
3

B3
S-
10

02
P

SW
2

B3
S-
10

02
P

10
K

R
21

G
N
D
A

10
0N

F

C
26

10
0N

F

C
22

10
0N

F

C
25

1

10
0N

F

C
17

1K R
37

1K R
36

G
N
D
A

G
N
D
A

G
N
D
A

1M
R
34

3/
31

/1
0

PI
C
24

 IC
D

10
0N

F

C
11

10
0N

F

C
13

G
N
D
A10

0N
F

C
21

G
N
D
A 4.
7K

R
23

4.
7K

R
30

G
N
D
A

ds
P
IC

33

10
0N

F

C
16

G
N
D
A2.

2K R
28

N
O
N
E

R
35

7.
37

28
M
H
Z

X3

+

47
U
F

C
23

10
0N

F

C
15

5 631 2 4P
6

H
D
R
6X

1

4.
7K

R
13

4.
7K

R
1910

0N
F

C
29

10
0N

F

C
19

10
0N

F

C
18

M
C
P
39

03
 E
va

l B
oa

rd
 fo

r 1
6-
bi
t M

C
U

ds
PI
C
33

FJ
25

6G
P7

10
-I/
PF

In
iti
al
 S
ch

em
at
ic
 D
es

ig
n

PGD/OCFA/RB7
27

PMPA7/RA9
28

PMPD3/RE3
99

PMPD2/RE2
98

AVDD
30

RG12
96

C1OUT/AN8/RB8
32

PMPD1/RE1
94

TDO/AN11/RB11
35

CVREF/AN10/RB10
34

RA6
91

RA7
92

VDD
37

RG1
89

U2RTS/RF13
39

U2CTS/RF12
40

RF0
87

VREG
86

AN13/RB13
42

SCL2/CN16/RD7
84

PMPA0/AN15/CN12/RB15
44

PMPRD/CN14/RD5
82

CN20/RD14
47

VDD
46

IC5/RD12
79

CN19/RD13
80

U2RX/RF4
49

RD2
77

IN
T1

/R
E8

18

VS
S

15

VD
D

16

M
C
LR

13

T4
C
K/
R
C
3

8

T2
C
K/
R
C
1

6

R
G
15

1

U
1T

X/
R
F3

51

SD
O
1/
R
F8

53
SD

I1
/R
F7

54

SD
A1

/R
G
3

56

R
A2

58

TD
O
/R
A5

61

TD
I/R

A4
60

O
SC

1/
C
LK

I/R
C
12

63

VS
S

65
IN
T3

/R
A1

4
66

IC
1/
R
TC

C
/R
D
8

68

IC
3/
R
D
10

70

R
C
13

73

O
C
1/
R
D
0

72

VS
S

75

R
A0

/T
M
S

17

IN
T2

/R
E9

19

T3
C
K/
R
C
2

7

T5
C
K/
R
C
4

9

VD
D

2

U
1R

X/
R
F2

52

SC
L1

/R
G
2

57

R
A3

59

VD
D

62

SC
K1

/IN
T0

/R
F6

55

IN
T4

/R
A1

5
67

IC
2/
R
D
9

69

IC
4/
R
D
11

71

O
SC

2/
C
LK

0/
R
C
15

64

R
C
14

74

AVSS
31

PGC2/RB6
26

PMPA6/RA10
29

RG14
95

RG13
97

PMPD4/RE4
100

VSS
36

C2OUT/AN9/RB9
33

TCK/RA1
38

AN12/RB12
41

RF1
88

VCAP/VDDCORE
85

RG0
90

PMPD0/RE0
93

VSS
45

PMPA1/AN14/RB14
43

CN21/RD15
48

U2TX/RF5
50

RD1
76

SS1/RD3
78

PMPWR/OC5/RD4
81

SDA2/CN15/RD6
83

PG
D
1/
AN

0/
R
B0

25

C
2I
N
-/A

N
2/
SS

1/
R
B2

23
C
2I
N
+/
AN

3/
C
N
5/
R
B3

22

C
1I
N
+/
AN

5/
C
N
7/
R
B5

20

PM
PA

4/
SD

I2
/C
N
9/
R
G
7

11
PM

PA
5/
SC

K2
/C
N
8/
R
G
6

10

PM
PD

5/
R
E5

3

PM
PD

6/
R
E6

4

PG
C
1/
AN

1/
C
N
3/
R
B1

24

PM
PA

2/
SS

2/
C
N
11

/R
G
9

14

C
1I
N
-/A

N
4/
C
N
6/
R
B4

21

PM
PD

7/
R
E7

5

PM
PA

3/
SD

O
2/
C
N
10

/R
G
8

12

U
7

DS51994A-page 18 © 2011 Microchip Technology Inc.



Schematics and Layouts
A.5 SCHEMATIC - MICROCONTROLLER (MCU)
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Schematics and Layouts
A.7 SCHEMATIC - POWER
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A.8 BOARD - TOP TRACE AND TOP SILK

A.9 BOARD - BOTTOM TRACE AND BOTTOM SILK
DS51994A-page 22 © 2011 Microchip Technology Inc.



Schematics and Layouts
A.10 BOARD - LAYER #2 VDD

A.11 BOARD - LAYER #3 GND
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A.12 BOARD - TOP SILK AND PADS

A.13 BOARD - BOTTOM SILK AND PADS
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MCP3903 ADC EVALUATION BOARD
FOR 16-BIT MCUs USER’S GUIDE
Appendix B. Bill of Materials (BOM)
TABLE B-1: BILL OF MATERIALS (BOM)

Qty Reference Description Manufacturer Part Number

2 C1,C4 CAP CER 10UF 16V Y5V 0805 TDK Corp. C2012Y5V1C106Z

25 C11<>C22 
C24<>C30 
C33,C34,C35 
C36,C39,C41

CAP CER .10UF 25V X7R 10% 0603 TDK Corp. C1608X7R1E104K

2 C2,C6 CAP CER 4.7UF 25V Y5V 0805 TDK Corp. C2012Y5V1E475Z

1 C23 CAPACITOR TANT 47UF 6.3V 20% SMD Kemet® T491A476M006AT

5 C3,C5,C44 
C45,C46

CAP CER .10UF 25V X7R 10% 0805 TDK Corp. C2012X7R1E104K

4 C31,C32  
C37,C38

CAP CER 18PF 50V C0G 5% 0603 TDK Corp. C1608C0G1H180J

12 C7,C8,C9, C10  
C51<>C58

CAP CER 68000PF 25V C0G 5% 1206 TDK Corp. C3216C0G1E683J

1 D1 LED 2X1.2MM RD/GN WTR CLR SMD Kingbright Corp. APHBM2012SURKCGKC

1 D3 DIODE SCHOTTKY 20V 0.5A SOD123 ON Semi. MBR0520LT1G

1 D5 LED BLUE 470NM CLEAR LENS (0603 
Blue)

Para Light Corp.  L-C191LBCT-U1

1 D6 LED 570NM GRN WHT/DIFF 0603 SMD Rohm Semi. SML-512MWT86

1 D7 LED RED 470NM CLEAR LENS   (0603 
Red)

Para Light Corp. L-C192KRCT-U1

4 Ea. Conner of 
PCB

STANDOFF HEX .500/4-40THR NYLON Keystone 1902C

4 Ea. Conner of 
PCB

SCREW MACH PHIL 4-40X3/8 NYLON Building Fasteners NY PMS 440 0038 PH

1 J1 CONN POWERJACK MINI .08" R/A T/H Switchcraft® RAPC722X

1 J2 Mini USB Type B Surface Mount Samtec MUSB-05-S-B-SM-A

1 J3 CONN D-SUB RCPT R/A 9POS 15GOLD Tyco Electronics 1734354-2

1 J4 "DO NOT INSTALL" 
120-pin MINI EDGE CARD SOCKET

Samtec MEC1-160-02-L-D-A

1 J5 3 x 1 Header 2.54mm -  -

8 JP1,JP2,JP3 
JP5,JP7,JP8 
JP9,JP10

3 X 2 Header 2.54mm on center 6 
mm/2.5mm

Samtec TSW-103-07-G-D

1 JP6 2 x 1 Header 2.54mm -  -

9 Jumper Shunts CONN JUMPER SHORTING TIN Sullins Connector 
Solutions

STC02SYAN

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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1 L1 Shielded 10uH Power Inductor 0805 Coilcraft 0805PS-103KLC

1 LCD1 "DO NOT INSTALL" -  -

1 LCD2 16X2 FTN Reflective No. BLWT COG 3V Tianma TM162JCAWG1

4 MOD1 25 X 1 Header 1.27mm on center Samtec MTMS-125-01-G-S-230

6 P0,P1,P2,P3 
P4,P5

CONN TERM BLK PLUG 6A 3.5MM 3POS Keystone 8723

1 P0,P1,P2,P3 
P4,P5,P11

TERM BLK PIN HEADER 24Pin Pos One 
24 Pin Header for 1 Board (20 pins 
needed)

Keystone 8724

1 P11 CONN TERM BLK PLUG 6A 3.5MM 2POS Keystone 8722

1 P6 6 x 1 Header 2.54mm -  -

1 P8 8 X 2 CONN HEADER 8POS .100" DUAL 
TIN

Samtec TSW-104-17-T-D

1 P9 "DO NOT INSTALL” -  -

1 PCB RoHS Compliant Bare PCB, MCP3901 
Eval. Board for 16-bit MCU 

- 104-00221

24 R1,R2,R3,R4 
R6,R8,R9  
R10,R16, 
R52,R62 
R84,R87 
R89<>R94 
R96,R99 
R101<>R104

(0805) "DO NOT INSTALL" -  -

4 R13,R19  
R23,R30

RES 4.70K OHM 1/10W 1% 0603 SMD Rohm Semi. MCR03EZPFX4701

8 R14,R20, R24, 
R31 R32,R33 
R36, R37

RES 1.00K OHM 1/10W 1% 0603 SMD Rohm Semi. MCR03EZPFX1001

3 R21,R57 RES 10.0K OHM 1/10W 1% 0603 SMD Rohm Semi. MCR03EZPFX1002

5 R17,R18,R25 
R29,R35

(0603) "DO NOT INSTALL" -  -

2 R15,R22,R26 RES 0.0 OHM 1/10W 5% 0603 SMD Rohm Semi. MCR03EZPJ000

2 R27,R28 RES 2.20K OHM 1/10W 1% 0603 SMD Rohm Semi.  MCR03EZPFX2201

2 R34,R40 RES 1.00M OHM 1/10W 1% 0603 SMD Rohm Semi. MCR03EZPFX1004

10 R38,R39,R43,R
54,R55,R56,R5
8 R63,R68,R69

RES 100 OHM 1/10W 1% 0603 SMD Rohm Semi. MCR03EZPFX1000

3 R41,R44,R47 RES 470 OHM 1/10W 5% 0603 SMD Panasonic ERJ-3GEYJ471V

7 R44,R70,R71, 
R72,R74,R75  
R76

RES 100K OHM 1/10W 1% 0603 SMD Rohm Semi.  MCR03EZPFX1003

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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Bill of Materials (BOM)
12 R5,R7,R11  
R12,R83,R85 
R86,R88,R95 
R97,R98 R100

RES 1.0K OHM .1% 1/4W 0805 SMD Susumu Co., LTD. RGH2012-2E-P-102-B

2 R59,R60 RES 10.0 OHM 1/8W 1% 0805 SMD Rohm Semi. MCR10EZHF10R0

4 SW1,SW2  
SW3,SW4

SWITCH TACT 6MM 230GF H=4.3MM Omron Electronic 
Components - 
ECB Division

B3S-1002P

1 TP1 Wire Test Point 0.3" Length Components Corp. PJ-202-30

1 U1 IC REG LDO 800MA 5.0V SOT-223 National Semi.  LM1117MP-5.0/NOPB

1 U3 IC REG LDO 800MA 3.3V SOT-223 National Semi. LM1117MP-3.3/NOPB

1 U6 IC DRVR/RCVR MLTCH RS232 20TSSOP Texas Instruments SN75C3223PWR

1 U7 "DO NOT INSTALL" -  -

1 U9 IC ENERGY METER 28SSOP Microchip MCP3903

1 X2 CRYSTAL 3.579545MHZ 18PFFUND 
SMD

Abracon Corp. ABLS-3.579545MHZ-B2-T

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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